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Chapter 1 - Overview

What is OTrack?

OTrack is a package that processes GPS data which has been collected by any
GPS device. OTrack analyses this data to provide you with performance
information and will tell you where you were at any time on a map of the area.

OTrack Features

k Display your route on the relevant map (or blank sheet).
k Compare your route with the route taken by others.
k. Analyse your fitness (time in heart rate zones, time in speed zones).

k Analyse your performance (leg split analysis). Compare your current
performance against previous sessions.

k Analyse how route choice affects your results.

k Coaches can download your GPS data while you are warming down and
discuss it with you within minutes.

k Use GPS data from any GPS unit. OTrack will direct connect to Garmin,
Magellan and SPI 10 devices. OTrack can also load data from files in GPX
format.

k Time lapse display of up to 5 runners on the same course. Time lapse display
of your performance on a specific circuit for up to 5 occasions.

k Create a time lapse display and mail it to your friends or post it on the web.

Who is OTrack For?

OTrack was initially designed for orienteering where it is important for the athlete
and coach to be able to reflect on where the athlete went in the context of the
map. However, OTrack can be used by anyone who wishes to analyse what they
did in a training session or event. Thisincludes street runners and walkers, cross
country, bike riders, circuit runners, etc.
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Gallery

Where did | go?

OTrack takes the data from your
GPS unit and displays it on your

map. You can also load the data 4

from other runners and compare
your route selection with theirs.

What was | doing?

At any point during your session
OTrack can tell you how far you
have travelled, how fast you are
going, how much climb you have
done, etc. You can also see what
other runners were doing at the
same time in their session.
OTrack displays the time line
information and your
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corresponding position on the map at that time.

What were my Leg Splits?

OTrack can provide leg split
analysis directly from the GPS
data. You do not need any other
electronic punching data. A leg is
the section of your GPS track that
you define and could be between
two street corners, the top and
bottom of a hill, home and the
furthest point out, successive
loops of a circuit, etc.
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Manual Conventions

The following typographical conventions are used throughout this manual:

text Indicates a menu or speed button on the screen.

text B text Indicates a menu hierarchy.

text Reference to another part of this manual.

<key> Indicates a key on the keyboard, e.g. <Alt>.

+ Two or more concurrent actions, e.g. <CtrI>+<End>+<Del>.
<click> Click the designhated mouse button.
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Chapter 2 - Getting Started

This section is intended to give the first time user some guidance to get going
with OTrack.

Minimum Requirements

You will need GPS track data to use OTrack. This data may come directly from
a GPS unit or from a data file containing GPS data which has been loaded by
somebody else.

It is also desirable (but not essential) to have a map image file. This file should
be of the area corresponding to the GPS data.

What To Do

The following steps represent one of the many ways to get going.

a. Start OTrack.

b. Press the El button on the toolbar to create a new and empty file.

c. Create a runner. Refer to New Runner.

d. Load the GPS data.
If you are loading data from a GPS you should firstly ensure that your GPS
unit is connected to the computer, and is operating correctly. Load the data
from the GPS unit as described in Load GPS Data, Load From GPS Unit.
If you are loading data from a file refer to Load GPS Data, Load From File.

e. Review the GPS data to ensure that the data you want is selected. GPS files
can contain data from a number of occasions. OTrack will only consider the
first 3 hours of the data. If you need to select a portion of the data refer to
GPS Data, Select GPS Data for assistance.

f. Load a map. Refer to Map, Load.

g. Enter the map scale. Refer to Map, Scale.
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h. Centre the GPS data on the map. Refer to Map, Align GPS Track.
i. Align the GPS data to the map. Refer to Map, Align GPS Track.

You are now ready to explore your data with the performance analysis, and
playback features available in OTrack.
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Chapter 3 - View

These options are accessed through View

Runner

This item toggles between Show Runners and Hide Runners.

The effect is to show or hide the runners list at the top left of the screen.

Statistics

This item toggles between Show Statistics and Hide Statistics.

The effect is to show or hide the statistics panel at the top of the screen.

Sector Statistics

This item toggles between Show Sector Statistics and Hide Sector Statistics.

The effect is to show or hide the sector statistics panel at the top of the screen.

Map

This item toggles between Show Map and Hide Map.

If you have loaded a map you can temporarily suppress the display of that map.
An equivalent area of blank map will be displayed on the screen.

Control Flags

This item toggles between Show Control Flags and Hide Control Flags.

The effect is to show or hide the map based control flags on the map area of the
screen.
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Zoom

This item displays a popup menu enabling you to control the magnification of the
map display. This popup menu can also be displayed by right-<click>ing over
the map display.

Focus

This item toggles between Enable Focus and Disable Focus.

When a position is selected on the time line display OTrack moves the position
markers for each active runner to their corresponding positions on the runner's
GPS track on the map display. If the new position of the marker for the first
runner is not visible on the map display then, if focus is enabled, the view of the
map will be adjusted so that the marker appears as close as possible to the
centre of the map display.

Panner

This item displays or hides a set of buttons to move (pan) the map display.
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Chapter 4 - Time Lapse Display

Time lapse display is accessed through the @ button on the toolbar.

How it Works

When you access the time lapse display a new map image is displayed. The
GPS data for each runner is drawn for each runner in segments. The length of
each segment is dependant on time lapse speed (the higher the speed the longer
the segment). This can result in a dashed effect when two or more runners
traverse the same path.

If you select a specific control point to start from, OTrack lines up all of the active
runners such that they all start from the one control point at the same time.
Using this function you can compare the performance of the runners on a
specific leg or legs of their course.

Controlling the Replay

The operation of the time lapse display is controlled through the following control
panel.

FPausze
I
| IO I I N I N N I N A I N I I N N N B N |
Slower Fazter
A | ae | ae

The position of this panel can be changed by dragging it to a new position. This
can even be done when a time lapse display is in progress.

» Clock

The real world elapsed in HH:MM:SS since the runners left the start point.

OTrack Version 1.11 Page 8



» Start
Press the Start/Stop button. The map is refreshed (clearing existing GPS
track data) and the GPS track data for the currently active runners is
progressively displayed.

>» Stop

Press the Start/Stop button. The display must be stopped, before you can
exit the time lapse display facility.

» Pause
Press the Pause button.
» Restart

Press the Pause button. More GPS data will be displayed from the previous
pause point.

» Replay Speed
The rate at which the data is displayed is controlled by the slider bar on the

control panel. The replay speed can be adjusted at any time, even when a
time lapse display is in progress.

Map Display

Press the __& | button to reveal or hide the map display control panel.

4 5 minfk

i
f+ Map ¢ 100%

" Course  BOX
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The map display options are:

Map The map display is scaled such that the whole map is displayed on the
available screen space.

Course OTrack determines the area of the map required to display all of the
control points. A border area equal to the Map Edge (refer to Options,
General) is added. This map segment is then scaled such that it is
displayed on the available screen space.

100% The map is displayed full size.

50% The map is displayed half size.

If the map does not fit on the screen, the viewed area may be adjusted using the
scroll bars, or by dragging the map with the left mouse button.

Start Point

Press the ___&® | putton to reveal or hide the replay start control panel.

-ql 1 m® v Toend

Use the arrow buttons to control the start control point for the runners. The
number identifies the leg, so “1" means from the start to the first control point.
If the To End check box is not checked then the replay will stop when all runners
have reached the next control point.

Runner Progress

Press the __&® | putton to reveal or hide the replay runner progress panel.

Run 2
Fun 3 e
Fun b HHE

The progress of each runner is displayed in terms of the number of control points
they have visited up to the replay time. OTrack “beeps” every time a runner
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passes a control. Thisis suppressed if the progress panel is not revealed during
the replay.

When the display is in progress, OTrack has the capability of keeping the current
position of one of the runners visible on the screen i.e. tracking. If the tracked
runner hits the edge of the screen, the screen will be scrolled such that the
tracked runner’s position is as close to the centre of the screen as possible. The
runner being tracked will have a “€” to the left of their name on the progress
panel. A runner to be tracked can be selected by <click>ing the name.
<Click>ing the name of the tracked runner will discontinue the tracking facility.
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Chapter 5 - Publishing

Map

This option is accessed through File » Save Map
The map with your GPS data track(s) marked on it can be saved to a jpeg, gif,

bmp file for use elsewhere. The image saved will take on the characteristics of
the map image displayed on the screen.

Player

This option is accessed through File § Save Player

The map with your GPS data track(s) displayed in time lapse replay can be
saved to "filename".exe file. This file contains the map (in gif format), the GPS
track data and a replay engine. This file can be distributed freely.

The player display is based on the settings you have used for the time lapse
display.

Note The player display may look different on another computer. The size of the
screen and colour settings for the display will affect the player display.

View in Google Earth

This option is accessed through File B View in Google Earth

The GPS data track(s) for all runners is bundled up into a kml file and exported
to Google Earth. If it is not going, Google Earth is then started. To control the
display of the data in Google Earth refer to Options, Google Earth for detailed
information.
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Chapter 6 - Screen Components
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Map Panel

The Time Line, Map and Statistics panels are all synchronised through the
Primary Runner. At any time a token will display the Primary Runner's position
on the map, a vertical line will display the corresponding position on the time line
and the statistics at that time will be displayed in the statistics panel.

The Map

The map display shows the GPS data of runners on a sheet. The sheet can be
a blank area or it can contain an image of a map.
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Display Order

OTrack displays each GPS track with the track colour you have allocated for a
runner.

The OTrack map display is organised on a bottom up basis. The GPS data for
the last runner is drawn first and the data for the first runner is drawn last.

Navigation

When the mouse is moved over the map sheet, the cursor will contain a coloured
dot. The dot colour will be that of the track colour of the Primary Runner. When
the mouse is <click>ed over the Primary Runner's GPS track, the time line
display will be adjusted such that the time line marker is at the same time as the
map position. If the time line marker would not be visible, the time line display
is scrolled. The statistics panel will also be updated to show the statistics at this
time.

If you want to refer to the second runner you must reorder the runners such that
the second runner becomes the Primary Runner.

The viewed area of the map can be adjusted with the scroll bars or by dragging
with the left mouse button. To do this, <click> on an area of the map which does
not contain an active (such as the track of the Primary Runner). Drag the map
to the desired position.

To zoom the map display, you may right <click> over the map to display a popup
menu of zoom options.

Time Line Panel

The Time Line, Map and Statistics panels are all synchronised through the
Primary Runner. At any time a token will display the Primary Runner's position
on the map, a vertical line will display the corresponding position on the time line
and the statistics at that time will be displayed in the statistics panel.

Time line information is only displayed for the Primary Runner. Therefore, the
length of the time line will be just sufficient to display the session data for the
Primary Runner. The range of information displayed is controlled through Tools
» Options #Time Line
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Navigation

|d|ﬂ|d|h|“|h|| .q|1 h-.|

A navigation bar has been provided to efficiently move around the Time Line.
The buttons perform the following functions:

Move the time line marker to the session beginning.

Move the time line marker back 3 minutes.

Move the time line marker back 1 second.

Move the time line marker forward 1 second.

Move the time line marker forward 3 minutes.

Move the time line marker to the session end.

[2]z[3]v]a o]z

Move the time line marker back to the previous control if one exits,

otherwise move the time line marker to the beginning of the session.
The current leg number is displayed.

L Move the time line marker forward to the next control if one exits,

otherwise move the time line marker to the end of the session. The
current leg number is displayed.

Runners Panel

The Time Line, Map and Statistics panels are all synchronised through the
Primary Runner. At any time a token will display the Primary Runner's position
on the map, a vertical line will display the corresponding position on the time line
and the statistics at that time will be displayed in the statistics panel.

The Runners Panel lists all runners which you have currently defined in this file.

This panel can be displayed or hidden using the View menu option. The panel
enables you to:

Enable/Disable Runners
If a runner is enabled (active) the GPS data for this runner will be displayed on

the map. A runner is enabled by checking or disabled by un-checking the check
box at the left of the runner's nickname in the Runners Panel.
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Change Runner's Colour

A colour select button has been provided for each runner to allow you to quickly
change the colour used to display the runner's GPS data on the map.

Edit Runner's Data
The Runners Panel contains each runner's nickname on a button. Pressing this

button will give you quick access to the dialog which allows you to edit their GPS
data, profile, etc.

Statistics Panel

The Time Line, Map and Statistics panels are all synchronised through the
Primary Runner. At any time a token will display the Primary Runner's position
on the map, a vertical line will display the corresponding position on the time line
and the statistics at that time will be displayed in the statistics panel.

Statistics are only displayed for active runners. The statistics which are
displayed is controlled through Tools B Options BStatistics

The statistics displayed for each runner commences with a header line containing
the runner's nickname. Beside the nickname is a rectangle which shows the
colour that is used to display the runner's GPS track on the map. Adjacent to this
box will be a red or green coloured dot. A green dot signifies that the runner's
GPS track passes through all of the marked control flag sites; a red dot signifies
that one or more of the control flag sites has not been visited. This will have an
impact on statistics such as leg splits, etc.

Sector Statistics Panel

A sector is a segment of the GPS track selected by the user. It is displayed in
a different colour. Statistics for that particular portion of the GPS track are also
generated.

The Time Line, Map and Sector Statistics panels are all synchronised through

the Primary Runner. Sectors can only be created for the primary runner and the
sector statistics only apply to the primary runner.
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Create Sector

A sector is created by:

a. Adjust the Time Line so that it displays the desired start time for the sector.
With the <Shift> button down left <click> on the start time. A sector of

duration 10 seconds will be created. Or,

b. On the Map left <click> on the primary runner's track while holding down the
<Shift> button. A sector of duration 10 seconds will be created.

Adjust Sector

The sector start and end points can be adjusted using the method outlined
above. Extending the sector is achieved by selecting a point outside of the
current sector. Shortening the sector is achieved by selecting a point within the
current sector. When shortening the sector, OTrack shifts the start to the new
point if it is closer than the end otherwise the end is shifted to the new point.
Clear Sector

A sector is cleared by right <click>ing in the Time Line panel with <Shift> button
down.
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Chapter 7 - Runners

OTrack is structured around the Runner and more specifically the Primary
Runner. The runner is the owner of any package of GPS data and any
performance profile. The OTrack map display is organised on a bottom up basis.
The Primary Runner is the runner at the top of the list of runners.

Runners can be different people running the same course at an event, the same
person running the same course at different times, or a person running
continuous loops around a training course. Each runner will be a unique
combination of a person and a package of GPS data. OTrack gives you the
capability of showing the performance of one of the these runners, or comparing
the performance of up to 5 runners simultaneously.

New Runner

This option is accessed through Runners B New Runner

A new runner will be created and control will be transferred to the Runner Profile
entry form to allow you to enter the characteristics of the runner and to load the
GPS data for the runner's session. The new runner will be added to the bottom
of the list of runners. To change this position refer to Reorder Runners.

Once the new runner process is started, the new runner can only be removed by
the Delete Runner process.

If the menu item Runners » New Runner is dimmed, you have reached the
maximum number of runners of five.

Delete Runner

This option is accessed through Runner b Delete Runner

A dialog box containing a list of runners will be displayed. Select the runnersyou
wish to delete one at a time and press Delete. The deletion of runners will only
occur when you press the Okay button to exit the dialog box. The order of the
runners is maintained. The first runner in the remaining list will become the
Primary Runner.
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Reorder Runners

This option is accessed through Runner B Reorder Runners

A dialog box containing a list of runners will be displayed. Selectthe runnersyou
wish to move up or down in the list and press the Move Up or Move Down
button. The Reordering of runners will only occur when you press the Okay
button to exit the dialog box. The first runner in the reordered list will become
the Primary Runner.

Runner Profile

These options are accessed through Runners # "Nickname" Profile

The runner's profile is a set of information (as detailed below) which is used to
identify a runner, their GPS data, and the performance characteristics to be used
to analyse their GPS data. A runner's typical profile can be saved and recalled
using the Select Profile... and Save Profile buttons. The profile is stored with
the particular GPS data and can therefore differ from the saved profile.
Runner profiles can be deleted through Tools B Delete Profile

» Name

A fifty character name used by OTrack to identify a runner and their profile.
This name should be unique.

» Nickname

A five character name used by OTrack to identify a runner. This is used by
OTrack to save space on the display.

» Heart Rate Zones
Five heart rate zones have been provided. The first zone starts at zero and
the last zone goesto "infinity". To set the zones, enter the span for each zone
in the box provided. OTrack will calculate the range of each zone from these
spans.

Note Heart rate zones must be entered in beats per minute.
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» Speed Rate Zones

Five speed zones have been provided. The first zone starts at zero and the
last zone goes to "infinity". To set the zones, enter the span for each zone in
the box provided. OTrack will calculate the range of each zone from these
spans.

Note Speed zones must be entered in kilometres per hour.

» Speed Limit
Sometimes, a GPS unit will generate a spurious result when it is having
difficulty e.g. inatunnel. This may be a location a long way away from where
you actually were. The speed that you must run to get to that location will
typically be very high.
OTrack will filter out this data by comparing this speed with the speed limit
you have set. The speed limit should be left at 0 (no filtering) unless it is
absolutely necessary to filter some GPS readings.

If you setalow speed limit, OTrack may become unstable because it will
attempt to filter out every GPS reading.
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Chapter 8 - GPS Data

GPS data records consist of:

* Timestamp

» Latitude

* Longitude

* Altitude

» Heart Rate (not recorded by all GPS units)

These records are collected by some GPS units at a regular time interval (such
as 1 per second, 1 every 5 seconds, etc) or when the GPS unit has detected a
shift of some distance (such as every 10 metres, etc). The GPS unit will
sometimes miss one or more of its observations. This is usually caused when
the GPS units lose sight because the tree canopy overhead is dense, you are
close to a cliff face, you are in a deep gully, etc.

OTrack assumes that it will have one observation per second. In situations
where the GPS unit has not recorded an observation(s) OTrack fills in the gaps
with synthetic observations based on constant speed and a straight line between
available GPS observations. OTrack displays actual GPS observations in blue
and synthetic observationsin red. Asthe number of red observations increases,
the value and accuracy of the information presented by OTrack decreases.

When operating the GPS unit, it is very unlikely that you will be able to start and
stop the GPS unit at the beginning of your session or orienteering course. Extra
records can be eliminated by OTrack.

If records are missing from the beginning or the end of a session, synthetic
records can be added. This can make the session time correct but cannot make
distances covered correct. As OTrack has no way of knowing where you came
from or where you are going or how fast you are going, it assumes that you are
standing still. On the other hand, some GPS units record multiple sessions for
multiple days in a single file. These usually have to be separated into individual
sessions for OTrack to process them.

The following sections of this help file will explain how you can refine the raw

GPS data and separate it into its component parts to maximise the information
provided by OTrack.
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Load GPS Data

These options are accessed through Runners B"runners nickname" GPS Data

GPS data may be loaded into OTrack from one of the following sources:
Load From OTrack Log

The OTrack Log file is a special file automatically created by OTrack when data
is read from a GPS unit.

The process of loading data from a GPS unit is typically very slow. Furthermore,
some GPS units will allow you to select the specific data you wish to load while
other GPS units require that you load all of the data in the unit and then select
the piece that you want.

The format of the OTrack Log is the same as any *.GPX file. You can therefore
save the OTrack Log as a "filename.GPX" file using Windows facilities. The
saved file can be used at a later date with OTrack or any other software which
can process GPX files.

To load the data from the OTrack Log:

a. Select OTrack Log from the Data Source drop down list.

b. Press the Load Data button.

c. If more than one track segment is found in the GPS data, dialog box will be
displayed asking you to select one of the segments.

Load From File

OTrack supports GPX format files and a number of other vendor specific formats
such as GXP.

a. Select the desired file type from the Data Source drop down list.
b. Press the Load Data button.

c. If more than one track segment is found in the GPS data, a dialog box will be
displayed asking you to select one of the segments.

Note Care should be taken when importing data from files in vendor specific
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files. For example, FRWD files record the date in the language of the computer
being used to export the data. This can be fixed by using the Select Data facility.

CSV Wizard

A CSV Wizard has been provided to handle the different data layouts available
in CSV (Comma Separated Variable) files. To enter the CSV Wizard simply
select “CSV files” as the data source, then experiment with the following
parameters so that the CSV file is decoded correctly.

Record Processing

Field Delimiter - The character used to enclose the data fields and is often either
“or not used. If a field delimiter is not used, ensure this is set to a character
which does not occur in the data.

Decimal Point - The character used as the decimal point in floating point
numbers.

Field Numbers

Select the number of the field in your data that contains each of the fields date
and time, latitude, longitude, altitude and heart rate. As altitude and heart rate
are not essential to OTrack they may be set to non existent field numbers.

Date Processing

Mask Processing. To enable translation of the date and time field, mask
processing of this field has been provided if the default (or no mask) processing
does not achieve the desired result. The mask will decode the date and time field
according to the following:

? ignore this character

a One character specifying the time of day (a for am, p for pm)

dd Two characters specifying the day as a number with a leading zero or
space (01-31)

ddd Three characters specifying the day as an abbreviation (Sun-Sat)

ddddd  Variable number of characters specifying the day as a full name
(Sunday-Saturday)

mm Two characters specifying the month as a number with a leading zero
or space (01-12)

mmm Three characters specifying the month as an abbreviation (Jan-Dec)

mmmm  Variable number of characters specifying the month as a full name
(January-December)
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yy Two characters specifying the year as a two-digit number (00-99)
yyyy Four characters specifying the year as a four-digit number (0000-9999)

hh Two characters specifying the hour with a leading zero or space
(00-23)

nn Two characters specifying the minute with a leading zero or space
(00-59).

SS Two characters specifying the second with a leading zero or space
(00-59)

z One character specifying the millisecond with a leading zero (0-9)

zz Two characters specifying the millisecond with a leading zero (00-99)

77z Three characters specifying the millisecond with a leading zero
(000-999)

A typical mask would be “dd?mm?yyyy?hh?nn?ss”.

Base Date. This option allows you to set the date and time of the first accepted
record. The records following are then time stamped relative to this date.

Sample Output

The first 100 records of the data file in accordance with the decoding parameters
you have chosen.

Load From GPS Unit

Before you can load data from a GPS unit you must first establish a connection
path between OTrack and the GPS unit. The dialog box to do this is accessed
through File # GPS Setup. Refer to Setup, GPS for detailed information.

You are now ready to download data from your GPS unit.

a. If necessary return to the Load From GPS facility via Runners B "runners
nickname" » GPS Data

b. Ensure your GPS unit is correctly connected to your computer, is turned on
and in the correct mode to talk to your computer. Consult your GPS Owners
Manual for assistance.

c. Select the desired GPS unit, COM port combination (identified in the process
above) from the Data Source drop down list.

d. Press the Load Data button.

e. If more than one track segment is found in the GPS data, a dialog box will be
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displayed asking you to select one of the segments.

Adjust Timestamp

This option is accessed through Runners B "runners nickname" # GPS Data

Coordinated Universal Time (UTC) is the international time standard. It is the
current term for what was commonly referred to as Greenwich Meridian Time
(GMT). Zero (0) hours UTC is midnight in Greenwich England, which lies on the
zero longitudinal meridian.

GPS records are tagged with a UTC timestamp. Some GPS units will adjust this
timestamp to reflect daylight saving and some will not. Furthermore, if GPS data
is recorded somewhere else in the world, the timestamp will probably reflect that
local time.

If the times shown in your GPS data do not reflect the correct time you can
adjust them. Use the UTC Ad] edit box to add a correction time. This
adjustment may have a "+" or a "-" in the first character position to move the
timestamps backwards or forwards. The adjustment set here is applied only to
GPS data loaded for this runner in this OTrack file.

Select GPS Data

These options are accessed through Runners § "runners nickname" » GPS
Data

Select Data

The Select Data option allows you to clip unwanted data from the front and/or the
end of the GPS data file you have loaded. When you have loaded a file
containing GPS data, OTrack stores a copy of that data in its own file. The data
which is clipped is removed from the OTrack data only. The source GPS file is
not touched. If you clip too much data you must reload the original GPS file into
OTrack to recover.

To select the required GPS data press the Select Data button. A window will
appear displaying the raw GPS data.

To set a new first record, locate the desired record in the list of records and

double <click> the First column of that record. "****" will then appear to indicate
the new first record and the "clipped records" will turn to grey.
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To set a new last record, locate the desired record in the list of records and
double <click> the Last column of that record. "****" will then appear to indicate
the new last record and the "clipped records" will turn to grey.

You may also set the time and date of your GPS records. When GPS data is
imported from other sources, OTrack will attempt to determine the time and date
when this data was collected. If the time and/or date is incorrect, new values
may be entered here.

Set Session

The Set Session option also allows you to mask out unwanted data. Set Session
does not remove any data, it moves the session window along the available data.
This is useful if you want to set your session start time using trial and error.

It also allows you to have a start time earlier than the first available GPS record
and a finish time after the latest available GPS record. It is also useful when you
are attempting to break GPS data which covers continuous loops of a training
course into individual sessions for comparison.

Two helper buttons have been provided to help you find the start j and find

the finish ﬂ of a session. You must first have established a map based control
site for the start and for the finish and have aligned your GPS track to the map.
OTrack searches along your GPS track data to establish the times at which your
track is closest to the start and to the finish. You may have to fine tune these
points manually.

To reset the session parameters to cover the available GPS records, press the
Reset button.

Note The session duration has a maximum value of 3 hours.

Export GPS Data

This option is accessed through Runners B "runners nickname" # GPS Data

After you have loaded GPS data, you will have the option of exporting the data
in one of the supported file formats.

To export the data, press the Export Data button.
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If you have loaded a large file from a GPS unit you can use this facility to make
a copy of data for reprocessing.
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Chapter 9 - Map

Load

This option is accessed through Map # Load Map

The load map option provides a dialog to enable you to load a map file.

Scan

These options are accessed through Map # Scan Map

Select Source

If you have more than one scanning device attached to your computer you must
select which device OTrack is to use to acquire your map image. If you only
have one scanning device OTrack will automatically select that device.

Scan

Press the Scan button to activate the Scan Dialog facility provided with your
scanner.

Save and Close

Press the Save and Close to create a permanent copy of your map file. OTrack
then loads this file as the map.

Rotate Image

Use the buttons ilﬂlil to rotate the map image by 90, 180 or 270

degrees. OTrack will adjust the vertical and horizontal dimensions of the image
during the rotation process.

Straighten Image

If the map image is askew (e.g. the northing lines are not quite vertical) you can:
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Vertical straighten

a. Pressthe ﬂ button. The rotate buttons will be deactivated while this button
is down.

b. <Click> on one end of a vertical reference on your map.

c. Drag the mouse to the other end of the vertical reference and release. The
map image will then be rotated so that the reference line is vertical.

d. Press the ﬂ button to reactivate the rotate buttons.

Horizontal straighten

a. Pressthe j button. The rotate buttons will be deactivated while this button
is down.

b. <Click> on one end of a horizontal reference on your map.

c. Dragthe mouse to the other end of the horizontal reference and release. The
map image will then be rotated so that the reference line is horizontal.

d. Press the j button to reactivate the rotate buttons.

Scale

This option is accessed through Map ¥ Scale Map

Use this option to set the scale of the map. OTrack uses this scale to convert
between distances on the map sheet and distances in the real world.

Centre GPS Track

This option is accessed through Map # Centre GPS Track

OTrack displays the loaded GPS data on a map. OTrack also provides the
ability to move, stretch and rotate the GPS track.

There will be situations where the track becomes distorted beyond recognition
or disappears. If this occurs, the GPS track can be recovered by centring the
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GPS track on the map.

Align GPS Track

Once you have a map loaded and a GPS track (GPS data) loaded you will want
to align the GPS track to the map. To achieve this undertake any or all of the
following steps that you need to do to achieve the desired result. Each step may
be undertaken a number of times.

Note If you experience problems when aligning the GPS track it may be
necessary to centre the GPS track again using Map # Centre GPS Track and
starting the alignment process afresh.

Anchor Points

OTrack uses two anchor points represented byi‘i‘ These anchor points are
used to identify a point on the GPS track and match it to a location on the map.

Adjust the Red Anchor

a. Pressthe ﬂ button on the toolbar. Any existing anchor points will now be
displayed on the map.

b. Move the mouse over the GPS track to a point on the GPS track which you
can identify on the map e.g. the start, finish or a control flag site.

c. Withthe <Shift> button down, press the left mouse button and drag the mouse
to the desired point on the map and release the mouse button.

If a blue anchor existed then the GPS track will be stretched and rotated without
affecting the blue anchor. If there is no blue anchor then the GPS track will only
be shifted.

Adjust the Blue Anchor

a. Press the ﬂ button on the toolbar. Any existing anchor points will now be
displayed on the map.

b. Move the mouse over the GPS track to a point on the GPS track which you
can identify on the map e.g. the start, finish or a control flag site.
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c. With the <Shift> button down, press the left mouse button and drag the mouse
to the desired point on the map and release the mouse button.

If a red anchor existed then the GPS track will be stretched and rotated without
affecting the red anchor. If there is no red anchor then the GPS track will only
be shifted.

Finally

Ensure that both buttons i‘i‘ on the toolbar are up. The anchor points
displayed on the map will now disappear.
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Chapter 10 - Options

General

These options are accessed through Tools B Options » General
Open last file

When OTrack starts it will load the last file you were accessing. Un-ticking this
box will prevent the last file from being loaded.

Extended search

When you load a map file OTrack saves the complete file name of the map.
This is used to open the map file the next time.

This occurs even if it is in the same directory as the *.otk file. If you email the
*.otk file to somebody else the map may not be able to be found unless you set
this option. Extended search option causes OTrack to look for the map under its
full name. If it cannot be found there, OTrack will then search the directory
containing the *.otk file.

Map Edge

There are situations where it is desirable to reduce the map size. For example,
when a GPS track occupies only a small segment of the map, the amount of map
which is printed to print the GPS track can be reduced to the GPS track size plus
the Map Edge amount all around the GPS track.

Default UTC Adjustment

Coordinated Universal Time (UTC) is the international time standard. It is the
current term for what was commonly referred to as Greenwich Meridian Time
(GMT). Zero (0) hours UTC is midnight in Greenwich England, which lies on the
zero longitudinal meridian.

GPS records are tagged with a UTC timestamp. Some GPS units will adjust this
timestamp to reflect daylight saving and some will not. Furthermore, if GPS data
is recorded somewhere else in the world, the timestamp will probably reflect that
local time.

Use the default setting to suit your local time and your GPS. A different
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adjustment can be used specifically for a set of GPS data when it is loaded.
Data Smoothing

The GPS data may cause zigzag patterns when it is rendered on the map, or
displayed as a speed curve. You may apply data smoothing to the XY
coordinates or to the speed data to reduce the zigzag effect. Non smooth data
is normal for orienteering as the GPS unit may have difficulty operating in
heavily treed areas or where running requires you to avoid objects or climb over
them.

Using trial and error, select a level of smoothing which provides the best result.
0 is no smoothing while 4 is the maximum.

Map

These options are accessed through Tools B Options » Map

Blank Map

When GPS data is loaded into OTrack it is displayed on a map. If a map does
not exist then OTrack creates a blank sheet as the map, with this colour. The
sheet is just big enough to display the GPS data.

Course

When OTrack displays the Course on the map it uses the following parameters
to render the artwork.

» Flag Font - The colour and text of the font to be used when drawing the text
on the flags which identify control sites.

* Flag Colour - OTrack uses this colour for the infill of a box with rounded
corners to identify the location of map based control flags which you have
defined.

» Dot Size - The size in millimetres of the dot drawn on the course to mark
control sites. Values range from O - 10.

* Line Width - The width in millimetres of the line used for displaying course
leg lines. Values range from O - 10.
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Runner

These options are accessed through Tools B Options » Runner
Track Thickness

The track thickness is the diameter of the pen which OTrack uses to draw the
track on the map.

Track Display

When OTrack draws the runner's track on the map it will use either the colour
you have selected for the runner or a colour which represents the speed zone of
the runner at that particular point.

Runner Token

Two different token types are provided to display the runner's current position on
the map. The token colour will be the same as the colour you have selected for
the runner. The position of the tokens is synchronised with the elapsed time
which is displayed in the Time Line display.

Sector

You may select a segment of the GPS track for analysis. The colour selected

here is used to display the sector on the map and also to identify the area on the
time line display.

Statistics

These options are accessed through Tools B Options # Statistics

OTrack can display a set of statistics about the active runners at their current
position as indicated by the map display and time line display. This panel is
made visible through View # Show Statistics

The statistics available are:

e Altitude

* Climb
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» Distance

» Elapsed Time
* Heart Rate

* Lead

* Speed

Time Line

These options are accessed through Tools B Options B Time Line

OTrack displays atime based graphic representation of some of the statistics for
runners. The length of the display is based on the duration of the GPS track of
the primary runner.

You can choose the Single Runner option to display the data for the primary
runner, or the Compare Runners option to compare data between the active
runners.

Single Runner

Any of the data items from the following list can be plotted on the time line
display for the Primary Runner:

* Altitude

* Climb

* Heart Rate
* Speed

The line colour for each of the data items on the graph can be selected via the
colour button adjacent to each item.

Compare Runners

One data item out of the following list can be plotted on the time line display for
each of the active runners:
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* Altitude

* Climb

» Distance

* Heart Rate
* Lead

* Speed

The line colour for the data items on the graph is that which you have selected
to represent each runner.

Units

These options are accessed through Tools § Options ¥ Units

Units for the display of speed, distance and altitude can be selected as follows.

Measurement

Unit

Speed

m/s (metres per second)

kph (kilometres per hour)

mph (miles per hour)

k/min (kilometres per minute)
min/k (minutes per kilometre) *

Distance

m (metres)

km (kilometres)
ft (feet)

miles (miles)

Altitude

m (metres)
ft (feet)

* |If the unit for speed is chosen to be min/k then an additional Max option will
be displayed. Enter a number from 1 to 100 which represents the maximum
minutes per kilometre value to be used by OTrack when generating charts.

Note When you are stationary your minutes per kilometre is infinite.
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Zones

These options are accessed through Tools # Options ¥ Colours
Zones

When OTrack displays the runner's GPS track on the map, it uses these colours
to represent the various speed zones of the runner.

GoogkaEaHh

These options are accessed through Tools » Options » Google Earth

The options set here are transferred to Google Earth to use when displaying data
being transferred from OTrack. For a detailed description of these parameters
refer to Google Earth's documentation.

Course

When Google Earth displays the Course layout it uses the following parameters
to render the artwork.

* Colour - The colour of the course lines and control site icons.

* Opacity -The opacity of the course artwork, with 0 being invisible and 100
being opaque.

» Icon Scale -The scaling factor for displaying control site icons. Values range
from 0.5 - 10.

* Line Width -The width of the line used for displaying course leg lines. Values
range from 0.5 - 10.

Runner

When Google Earth displays the path for each runner it uses the colour you have
already identified in OTrack for each runner along with the following:

e Line Width -The width of the line used for displaying the runner's path.
Values range from 0.5 - 10.
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Chapter 11 - Control Flags

OTrack uses control flags to identify the start and end of a course and the
location of any control points (sites) along a course.

OTrack assumes that the session start location and the Str flag are at the same

location on the map. It also assumes that the session end and the Fin flag are
at the same location.

Map Based Flag Sites

These are flag sites which are at some position on the map e.g a boulder, gully,
watercourse, street corner, hotel, etc.

The accuracy of the position of these map based flag sites will depend on the
accuracy of the map being used and the accuracy of the placement of the
corresponding control point “on the ground”. For example, mappers will
sometimes stretch parts of the map to improve the readability of the map. Such
maps will look okay but the absolute position of objects will not be precise in
terms of GPS coordinates. This will result in GPS data not quite matching the
map or not quite visiting some control sites.

OTrack processes a runner's GPS data and determines when the runner is
closest to the map based flag site. The runner is considered to be at the control
point. In some situations, this may not be a valid assumption. For example, the
map may be wrong or the athlete (e.g. orienteer) has run past a control point
without seeing it and coming back later to punch the control.

Time Based Flag Sites

These are flag sites which are defined to be at some elapsed time after the
runner has started their course.

There are a number of sources which can provide times for this purpose:
» Split times from Sportident.
» Times from watches which have leg time capability.

» Examining the time line speed curve to determine when you may have
stopped e.g. an orienteer stops to punch a control.
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» Examining the shape of the GPS track e.g. sharp changes in direction.

Time based flag sites will overcome the problems associated with running past
a control or slowing to search for a control.

It may be necessary to use time based flag sites if OTrack considers that you

have not visited a control because your GPS track did not pass sufficiently close
enough to a map based flag site which you have defined.

Establishing Control Flags

There are three different techniques for establishing control flag sites:
(a)From Corpse (an orienteering software package)

(b)User Entry
(c)From Time Splits

Control Flags - Corpse

Control flag sites established this way are positions on the map - map based.
If Corpse 6.2 or later has been used to plan the orienteering course, the
information required to position control flags on the map for OTrack is attached
to the EPS files created by Corpse.

To access this information you must have loaded the relevant course EPS file
as the map for OTrack. If this has been done, Map B Load Flag Sites will be

enabled. Selecting this option will download the flag site locations as map based
control flag sites.

Control Flags - User Entry
Control flag sites established this way are positions on the map - map based.

To enter the flag sites manually:

a. Pressthe [ button on the toolbar. Many OTrack functions will be disabled
while this button is down.

b. Select a flag (if there are any flags) by <click>ing over the flag number in the

Flag List or by <click>ing over the flag site on the map. Any new flag site
created will be positioned in the list after the selected site.
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c. Add a new flag site using one of the following methods.

1. Using the Flag List

Add a new flag by pressing the 3 button. Thiswill add a new flag to the
list and position the flag at the centre of the map. It may then be dragged
to the correct place on the map by using the mouse to drag it.

2. Using the Time Line
Move the mouse over the time line to the exact time that the primary
runner is thought to be at the flag site and double <click>. This will add a
new site to the list on the primary runner's path and will place it in the list
in the correct chronological sequence. If the site is not in the correct place
on the map then it may be moved by using the mouse to drag it to the
correct place on the map.

3. Using the Map
Move the mouse over the map to the desired site and double <click>.
This will add a new site to the list. If the site is not in the correct place then
it may be moved by using the mouse to drag it to the correct place.

d. Repeat steps "b." and “c.” until all flag sites have been added.

e. Press the button on the toolbar to leave the control flag edit mode.

Control Flags - From Time Splits

Control flag sites established this way are at elapsed times from the beginning
of the session or course - time based. These flag sites will apply to the particular
GPS data for the session.

To enter these flag sites:

a. Select the Runner from the drop down list of runners from Runners on the
main menu bar.

b. Select the Leg Times tab.

c. If map based flag sites exist, the time splits associated with these can be
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transferred to the leg times list by <click>ing the Load Map Sites button.

d. Select the leg time you wish to enter and press <Enter>. Enter the time and
press <Enter>. The Leg Times sheet will be automatically updated as you
go. Legs can be added by entering a time at the bottom of the list.

e. Alegtime can be removed from the list by selecting the leg time and pressing
<Del>.

Shifting the position of a flag site along the GPS data is the same as increasing
or decreasing time for one leg while decreasing or increasing the following leg
time. Buttons have been provided to make this combined adjustment by 1
minute or 1 second at a time. The time of either leg cannot be reduced to less
than one second with these buttons. If you wish to have OTrack use these time
based flag sites, tick the check box provided.

Control Flags - Edit Map Based Flag Sites

To edit the map based flag sites:

a. Press the &2 button on the toolbar to reveal the Flag List. Many OTrack
functions will be disabled while this button is down.

kr rs

€[> |1t |4,

5
1
2
3
4
5
3
7
a
|
1

o w

a

b. Buttons adjacent to the flag list enable you to add and remove flags or to
change a flag's sequence number for a course.

c. To alter the position of a flag on the map, select it by <click>ing over the flag
number in the Flag List or by <click>ing over the flag site on the map. It may
then be moved by using the mouse to drag it to the correct place on the map.

Note A control can be brought into view on the map using the map's scroll
bars or by double <click>ing the flag number in the flag list.
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d. Press the button on the toolbar to leave the control flag edit mode.
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Chapter 12 - Setup

GPS

These options are accessed through File B GPS Setup

Basic Settings

a.

Ensure your GPS unit is correctly connected to your computer, is turned on
and in the correct mode to talk to your computer. Consult your GPS Owners
Manual for assistance.

. Select the type of GPS unit you have from the GPS Unit drop down list.

Select the GPS data transfer speed to be used from the Data transfer speed
drop down list. Consult your GPS Owners Manual for assistance in choosing
an appropriate value. Itis likely that the OTrack defaults will be appropriate.

. Press the Test button. OTrack will search all COM ports on your computer

for the GPS unit. If found, OTrack will display hame of the GPS unit and the
name of the COM port to which it is found. If it is not found then you may
have selected the wrong unit or the wrong speed. You may have to reboot
your computer as Windows may not have recognised the existence of your
GPS unit on one of the computer's COMSs ports.

. You will need to use this GPS unit and COM port combination whenever you

are going to load data directly from your GPS unit.

Advanced Settings

These settings should only be adjusted as a last resort. Before making any
changes, record the current settings and store them in a safe place.

The parameters which can be adjusted are:

Read wait time (milliseconds) - The additional time OTrack will wait for a
read operation to complete after the GPS unit has been requested to send
data. The internal processing speed of a GPS unit can be quite slow resulting
in a delay between a request for data and the actual transmission of the first
piece of data.
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* Write wait time (milliseconds) - The time OTrack will wait for a write
operation to the GPS unit to complete. OTrack write operations will normally
be very short as they are limited to sending acknowledgements of a
successful read operation from the GPS unit.

* Retries - The number of additional times a read/write operation will be
attempted if the original read/write operation failed.

Adjusting these parameters will affect the successful reading of data from your

GPS unit. Adjustments may improve read times or on the other hand prevent
successful reading of data.
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Term
Altitude

Climb

Distance
Elapsed Time
Heart Rate

Speed

Meaning
Height above sea level as recorded by the GPS unit.

The sum of all of the positive altitude changes (increases in
height) since the beginning of the GPS data.

The distance travelled since the beginning of the GPS data.
The time that has elapsed since the beginning of the GPS data.
Heart rate in beats per minute as recorded by the GPS unit.

The current speed of the runner.
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